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Introduction

Microsoft® Windows: Questions and Answers provides solutions
to common problems that often arise when you are using the
more advanced features of Microsoft Windows. The questions and
answers are organized under the following topics :

•

	

"DOS Requirements," defines the DOS versions required by
Windows .

•

	

"Taking Advantage of Memory," contains information on how
Windows uses memory, and provides procedures for setting up
extended and expanded memory .

•

	

"Printing Files and Adjusting Printer Settings," defines printer-
output files and explains printing to serial devices .

•

	

"Running Windows Applications," explains how to use Win-
dows with applications, and how to convert font files .

•

	

"Using Paint with Windows," contains information on color,
high-resolution monitors, and plotter output .

•

	

"Using a Modem with Windows," explains how to adjust
automatic answering .

•

	

"Running Standard Applications," contains information on
adjusting PIF file settings, and using a mouse with Windows .

•

	

"Additional Information," describes various other Windows
topics.

To use this guide, decide which main topic your question falls
under. Then, scan the sideheads in each topic section . The side-
heads point to questions and explanations for specific problems .
If you do not find the answer to your question in this booklet, or
in the Microsoft Windows User's Guide, see the README.TXT file
included on your Microsoft Windows Write Program disk . If you
still have questions about using Windows, call Microsoft Product
Support Services .
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Questions and Answers

DOS Requirements

0 : Which version of DOS is required to run Windows 2 .x?

	

Choosing the correct
version of DOSA: To run Windows 2 .x, you must use DOS 3 .0 or later. This

is a correction to the DOS version information in the Microsoft
Windows User's Guide .
0 : Which version of DOS is required to run Windows/386?
A: To run Windows/386, you must use DOS 3 .1 or later .

Taking Advantage of Memory

Q : What should I know about conventional, extended, and

	

Using expanded
expanded memory when using Microsoft Windows?

	

memory with
A: The following information should be used when setting

	

Windows
up memory for use with Windows . If you already understand
extended and expanded memory, you may want to skip the fol-
lowing "Memory Overview" and go straight to "Setting Up
Extended or Expanded Memory ." However, if you want to learn
about memory, the following information will be helpful .

Memory Overview

When using Windows, you should be aware of three different

	

Different kinds of
kinds of memory:

	

memory

•

	

Conventional
•

	

Extended
•

	

Expanded

Conventional, Extended, and Expanded Memory

Conventional memory is where applications (such as Microsoft
Word) reside when you run them . All computers have conven-
tional memory .

3
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In addition to conventional memory, your system may have two
additional types of memory : extended or expanded . Most 80386-
based computers have some extended memory; however, for
80286-based computers, generally you must purchase an extended
or expanded memory board and install it in your computer .
Extended and expanded memory improve the performance of
Windows .
There are two general types of memory boards : those that have
only extended memory, and those that can be set up to have
extended memory, expanded memory, or both .
If your system uses expanded memory, you must have an
expanded memory manager (a program that controls expanded
memory). Adding an expanded memory manager to your system
is discussed under "Setting Up Extended or Expanded Memory ."
Windows includes expanded memory managers for the following
expanded memory boards (located on the Windows Utilities 2
disk) :

•

	

Intel Above Board
•

	

AST RAMpage!
•

	

IBM PS/2 80286 Memory Expansion Option

The setup procedure described in the following "Setting Up
Extended or Expanded Memory" section automatically sets up
your expanded memory manager .
For more information on the expanded memory manager for your
system, see the following text file that corresponds to your
expanded memory board (located on the Windows Utilities 2
disk) :

If you have

	

See

Intel Above Board

	

EMM.TXT
AST RAMpage!

	

REMM.TXT
IBM PS/2 80286 Memory

	

PS2EMM.TXT
Expansion Option (Model
50 or 60)



Note Some expanded memory managers for other expanded
memory boards are not included with Windows . However, you
can use any expanded memory board that includes its own
expanded memory manager that meets full LIM 4 .0 specifications.
To determine if your expanded memory manager meets full LIM
4.0 specifications, see your memory board manual, or contact the
manufacturer .

Two DOS utilities included with Windows reduce the time

	

Using SMARTDrive
needed for retrieving information from your hard disk: SMART-
Drive and RAMDrive . These utilities require that memory be set
aside for them . You can use conventional memory ; however, it is
recommended that you use extended or expanded memory
instead. It is recommended that you use SMARTDrive. To use
RAMDrive, see RAMDRNE.TXT located on your Windows Utilities
2 disk.

Setting Up Extended or Expanded Memory
If you have an extended memory board, simply install the board

	

Choosing between
following the manufacturer's instructions,

	

extended and
If you have a memory board that can be set up with expanded

	

expanded memory
memory, extended memory, or both, you must decide before
installation which kind of memory you want to use . The following
list shows you how to set up your expanded or extended memory
board to achieve the best results with Windows :

If you have

IBM PC AT (or 100
compatible)

IBM PC, XT (or 100% compati-
ble), and PS/2 Models 25,
30, 50, 60
80386-based computer

Set up

64K (or the minimum the
board allows) as extended
memory, and the remainder as
expanded memory
All memory as expanded

All memory as extended (use
Windows/386 )
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Installing extended or To install extended or expanded memory (after choosing between
expanded memory

	

extended and expanded memory and after installing your memory
board), follow these steps :

0 Insert the Windows Utilities 2 disk in drive A .
Run the MEMSET.EXE program by typing the following at the
DOS prompt :
a: memset
The MEMSET.EXE program analyzes your system memory .
Follow the instructions on your screen .
MEMSET.EXE recommends the best memory configuration
based on the answers you provide to the questions you see
on your screen. It then modifies the device = line in your
CONFIG.SYS file .

Note If you are using an application that directly uses expanded
memory for storing data, such as Microsoft Excel, do not allocate
all expanded memory to SMARTDrive . Save enough expanded
memory for the application to use for its data files (512K is
recommended). Use the remaining memory for SMARTDrive .
Since large applications such as Microsoft Excel need the largest
portion of memory, always start them before starting other Win-
dows applications .

For more information on setting up SMARTDrive, see Appendix C,
"Speeding Up Windows with SMARTDrive," in the Microsoft
Window's User's Guide . However, there is one correction : if you
do not specify an amount of memory, SMARTDrive will receive all
expanded memory (the default size), or 256K extended memory
(the default size) .

RAMDrive and

	

Q : Are there size limits for a RAM disk set up with RAMDrive,
SMARTDrive limits

	

or a disk cache set up with SMARTDrive?
A: Each is limited to 4096K. You can have only one SMART-
Drive disk cache, and therefore, only one SMARTDRV .SYS line in
your CONFIG.SYS file. However, it is possible to have multiple
RAMDrives by listing RAMDRV.SYS more than once in your
CONFIG.SYS file .



Q : I have expanded memory. When I use the About command

	

Memory
in the File menu in MS-DOS® Executive, it reports a different

	

discrepancies
amount of available expanded memory from that reported by
my application. For example, after I start Microsoft Excel, switch
to MS-DOS Executive, and use the About command, it shows
250K less expanded memory than Microsoft Excel reports
Why are these numbers different?
A: Microsoft Excel takes approximately 250K of expanded
memory when it starts, and it keeps this amount for its use . Micro-
soft Excel includes this amount when it calculates free expanded
memory. MS-DOS Executive does not see this memory as being
free, since it is not available to other applications . Therefore,
Microsoft Excel shows 250K more free expanded memory than
MS-DOS Executive. You may see this type of memory discrepancy
in other applications as well .

Q : After I start several Windows applications, there is little

	

Not enough memory
memory left over for data. Will adding an expanded memory

	

for data
board help?
A : An expanded memory board will help if your applications
store data in expanded memory. For example, Microsoft Excel
stores its worksheets in expanded memory .

Q : Page 189 of the Microsoft Windows User's Guide suggests

	

Setting the -1
using -1 in the Memory Desired box of a PIF file to instruct

	

PIF-file swap option
Windows to swap memory. Why won't Windows/386 accept this
value?
A : There is no need to put -1 in a PIF file for a standard appli-
cation in Windows/386 . Windows/386 manages applications and
memory differently from Windows 2.x. Each standard application
has its own block of memory, so Windows/386 does not obtain
additional memory by swapping memory.

Q : Why does the "Not enough disk space to run" message

	

Not Enough Disk
appear when I start a Windows application?

	

Space to Run
A: This message may appear for one of the following reasons :

	

message

∎ There is not enough disk space to create temporary files .
Some Windows applications create temporary files to store
data while you work, before it is saved to a file on a disk. To
correct this problem, delete any unnecessary files, and restart
your application .

7



8 Microsoft Windows : Questions and Answers

∎ The set TEMP line in your AUTOEXEC.BAT file is incorrect.
Make sure the line exists, and that it correctly specifies an
existing drive and TEMP directory. For example, the following
statement tells a Windows application to create temporary files
in a directory called TEMP located on drive C :

set TEMP=c : \TEMP

For more information on temporary files, see Chapter 1, "Getting
Started," and Chapter 5, "Using MS-DOS Executive," in the
Microsoft Windows User's Guide .

Printing Files and Adjusting Printer
Settings

Sending printer

	

Q : Can I send printer output to a file instead of sending it to
output to a file

	

my printer?
A : You can send printer output to a printer-output file . This
is a file that has been formatted for printing and which contains
printer control characters. To send printer output to a file,
rather than directly to your printer, follow these steps :

11

11

4

Start Notepad by running the NOTEPAD .EXE program from
MS-DOS Executive .
Open your WIN.INI file.
Add the following line below the [ports] section of your
WIN.INI file :
[drive :]filename =
The drive letter is optional. The current drive and directory
are used if you do not specify a drive or directory .
For example, to send printer output to a file called
OUTPUT.PRN, include the following line in your WIN.INI file :

OUTPUT .PRI@

Save the changes to your WIN .INI file .
Quit and restart Windows .
You must quit and restart Windows so that Windows will
recognize the changes you made to your WIN .INI file.



Q : How do I print printer-output files from MS-DOS Executive? Printing a printer-
output fileA : A printer-output file has been formatted for printing and con-

tains printer control characters. To print a printer-output file from
MS-DOS Executive, follow these steps :

Select the printer-output filename you want to print ; for exam-
ple, OUTPUT.PRN.

•

	

Select the File menu and choose the Copy command .
•

	

Specify the printer port in the To text box .
Press ENTER.

0

4

Note Do not use the Print command in the File menu . This com-
mand formats a specified file and sends it to your printer . If you
print a printer-output file by using the Print command, it refor-
mats the file and duplicates printer control characters. The result
is garbled printer output .

Q : When I try to print with a serial printer or a serial plotter,

	

Printing with a serial
either nothing happens, or the output is incorrect or incomplete,

	

printer or serial
A : Before you print, you must set up a serial communications

	

plotter
port.
To set up a serial communications port, follow these steps:

0

4

Fl
s

8

Start Control Panel by running the CONTROL.EXE program
from MS-DOS Executive .

•

	

Select the Setup menu and choose the Communications Port
command.

•

	

Set Baud Rate to 9600 .
Set Word Length to 8 .
Set Parity to None .
Set Stop Bits to 1 .

•

	

For a serial printer, set Handshake to None . For a serial plotter,
set Handshake to Hardware .
Press ENTER.

Note Printer errors may also be caused by incorrect cable con-
nections. For information on your printer calhes, see your printer
manual .

9
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Spooler capacity

For information on Control Panel and setting up communications
ports, see Chapter 7, "Using Control Panel," in the Microsoft Win-
dows User's Guide .

Q : Is there a limit to the number of printing jobs Spooler can
hold?
A : Spooler can hold as many as 20 printing jobs for each printer
port.

Running Windows Applications

System Error :

	

Q : What does it mean when the "System Error . Reading Temp
Reading Temp Files

	

files" message appears?
message A: This message may appear when Windows 2 .x uses a program

(for example, SPOOLER.EXE) from a previous version of Win-
dows, such as Windows 1 .0.
To update Windows and remove old Windows programs, follow
these steps :

0

4

n

Save any files you want to keep in a temporary directory (be
sure to copy any special PIF files) .
Delete Windows 1 .0 .
If you have subdirectories for applications that ran under Win-
dows 1 .0, or that include a run-time version of Windows, go to
those directories and check for old versions of CLIPBRD .EXE,
CONTROL.EXE, and SPOOLER.EXE. If they exist, rename or
delete them .
Install Windows 2 .x. Make sure that the Windows 1 .0 path is
no longer specified in the PATH line in your AUTOEXEC .BAT
file .
Copy the files you saved in Step 1 into your Windows 2 .x
directory.

Note Your WIN.INI file is renamed WIN.OLD when you install
Windows 2 .x over an earlier version of Windows . You can rename
this file to WIN .INI if it contains important information . You can
also use Notepad to copy information from WIN .OLD into your
new WIN.INI file .



Q : Why do some letters appear as black squares or nonsense

	

Nonsense characters
characters when I use particular fonts in some Windows

	

in Windows
applications?

	

applications
A: Some Windows applications include font files (files with a
.FON extension) ; for example, PageMaker 1 .OA. Font files designed
for use with earlier versions of Windows will not work correctly
with Windows 2.x or Windows/386. Use the NEWFON .EXE pro-
gram included with Windows 2.x and Windows/386 to convert
your old font files to the new format .
To convert font files, follow these steps :

El

4

Move to the drive and directory where your old font files are
located .
Fonts may exist in several different directories . If so, repeat the
following steps in each directory.

•

	

Create a backup copy of the old font files by typing the follow-
ing at the DOS prompt :
copy *.fon *. bak

•

	

Insert the Windows Fonts 1 disk in drive A .
Start the NEWFON.EXE program by typing the following :
a: newfon old-font-filename
Press ENTER.

To convert all existing fonts to the Windows 2 .x font format,

	

Converting all font
follow these steps :

	

files

0

To convert the PageMaker PMFONTA.FON, PMFONTB.FON, and
PMFONTE.FON font files, follow these steps :

0

Insert the Windows Fonts 1 disk in drive A .
•

	

Type the following at the DOS prompt :
a: newfon *.fon

•

	

Press ENTER.

Insert the Windows Fonts 1 disk in drive A .
Convert the PMFONTA.FON font file by typing the following at
the DOS prompt :
a: newfon pmfonta.fon

•

	

Press ENTER.

Converting
PageMaker font files
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4

L
s

Convert the PMFONTB .FON font file by typing the following at
the DOS prompt :
a:newfon pmfontb .fon
Press ENTER.

Convert the PMFONTE.FON font file by typing the following at
the DOS prompt:
a:newfon pmfonte.fon
Press ENTER.

Using Paint with Windows

Paint does not run in

	

Q: Why doesn't Microsoft Windows Paint run in color?
color A : Paint was not designed to run in color because displaying

color bitmaps requires three times the memory required to
display a monochrome bitmap .

Using Paint with

	

Q: Why is only the top half of my screen used when I am run-
high-resolution

	

ning Paint on a high-resolution monitor?
monitors

	

A: A Paint bitmap is limited to 64K; however, some high-
resolution monitors allow bitmaps larger than 64K . These moni-
tors display Paint bitmaps in the top half of the screen .

as the output device, the Paint Print command in the File menu is
grayed, and cannot be chosen .

Using a plotter with
Paint

Q :

A :
Can I send output to a plotter using Paint?
Plotters are not supported by Paint . If a plotter is designated



Using a Modem with Windows

Q : Why does my modem answer automatically, even when it is Modem answers
set for manual answering?

	

automatically
A: Some modems switch to an auto-answer mode when used
with Windows. To correct this, follow these steps :

0

4

Running Standard Applications

Q : Why does a "Load file not found" message appear when I

	

Load File Not Found
try to run a standard application using its PIF file?

	

message
A : This message may appear when the Initial Directory setting in
the PIF file is incorrect . This setting tells Windows which drive
and directory to go to when an application is started .
To correct the Initial Directory setting, follow these steps :

0

4

11

Start Notepad by running the NOTEPAD .EXE program from
MS-DOS Executive .

•

	

Open your WIN.INI file .
•

	

Add the following line below the [windows] section of your
WIN.INI file :
modem = none
Save the changes to your WIN.INI file .

•

	

Quit and restart Windows .
You must quit and restart Windows so that windows will
recognize the changes you made to your WIN.INI file .

Start PIF Editor by running the PIFEDIT .EXE program from
MS-DOS Executive .

•

	

Select the File menu and choose the Open command . You will
see a dialog box listing all available PIF files .

•

	

Select the PIF filename you want to edit, and press ENTER.

In the Initial Directory text box, type the drive and directory
where your application is located .
Save the changes to your PIF file .
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Insert Program Disk

	

Q: When I try to run a standard application such as Microsoft
message

	

Word, I am asked to insert the program disk into drive A . Why
does this message appear when the program is installed on my
hard disk?
A : This message may appear when Windows cannot find the
application you are trying to run . You need to correct the pro-
gram name in the corresponding program PIF file. To make this
correction, follow these steps :

0

4

Start PIF Editor by running the PIFEDIT .EXE program from
MS-DOS Executive .

•

	

Select the File menu and choose the Open command . You will
see a dialog box listing all available PIF files .

•

	

Select the PIF filename you want to edit, and press ENTER.

Type the application filename in the Program Name text box .
If the application is in a subdirectory, type the full pathname
including the drive letter .

•

	

Save the changes to your PIF file .

Using a mouse with a Q : Why doesn't my mouse work when I run a standard appli-
standard application

	

cation with Windows?
A : Standard applications (applications written for DOS rather
than Windows) have special files called "mouse drivers" that con-
trol the mouse . Under normal circumstances, these mouse drivers
are started by using DOS when you run an application . If you run
an application with Windows, mouse drivers must be started
before starting Windows . For information on your mouse and
mouse driver, see your mouse manual .

Additional Information

Running Windows/386 Q : Why does my system occasionally crash when I run
on Ungermann-Bass

	

Windows/386 on an Ungermann-Bass or 3Com network?
or 3Com networks

	

A : Recent releases of Ungermann-Bass and 3Com network
software contain two programs that do not run properly with
Windows/386 : PSCLOSE.COM on the Ungermann-Bass network,
and PRTSC.EXE on the 3Com network. At this time, you cannot



use these two programs. To prevent these programs from running,
follow these steps :

Start Notepad by running the NOTEPAD .EXE program from
MS-DOS Executive.

•

	

Open your MSNET.INI file.
This file is usually located in the \net, \network, or \ubnet
directory.

•

	

Delete the line from the [net start urdr] section of your
MSNET.INI file that contains the PSCLOSE.COM or PRTSC.EXE
program .
Save the changes to your MSNET .INI file.
Quit Windows .
Restart your system .
You must restart your system so that it will recognize the
changes you made to your MSNET.INI file .

0

4

s

For more information on these programs, contact your network
software salesperson .

Q : What network hardware works with Windows?

	

Compatible network
hardwareA : The following network hardware works correctly when used

with Windows 2.x or Windows/386 version 2 .03 or later :

•

	

3Com Etherlink
•

	

3Com Etherlink2
•

	

AT&T Starlan
•

	

IBM PC Network
•

	

IBM Token-Ring
•

	

SMC ArcNet
•

	

Ungermann-Bass NIU

While other network hardware may work, Microsoft does not
guarantee Windows support for other network hardware .

Q : What network software works with Windows?

	

Compatible network
softwareA : Windows works with any 100% Microsoft Networks

redirector-based network shells. To determine if your network
software meets this specification, contact the network software
manufacturer.
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Windows works with the following non-Microsoft Networks
redirector-based network shells, provided they are the latest
versions available :

•

	

Novell NetWare
•

	

Banyan Vines

While other network software may work, Microsoft does not
guarantee Windows support for other network software .

Expanded memory

	

Q : My system configuration includes expanded memory, a net-
board hardware

	

work card, and a terminal-emulation board. I have correctly
conflicts

	

installed both the expanded memory board and the expanded
memory manager. Can multiple hardware boards conflict with
one another?
A : Some hardware boards, including some network and
terminal-emulation boards, cause memory conflicts when used
with an expanded memory board. The conflict occurs when both
boards try to use the same memory . The conflict may cause a mal-
function of either the expanded memory board or the other
boards. If you experience these problems, call Microsoft Product
Support Services .
It is possible to work around this problem by changing the
memory address used by the expanded memory board (your
memory board uses this address to communicate with your
:omputer).
To change the memory address, follow these steps :

0 Determine the address range for the "other" board . For infor-
mation on the address range your board uses, see the board
manual, or contact the manufacturer .
Set the /x parameter of the expanded memory manager
device = line in your CONFIG.SYS file .
For example, the IBM 3270 Terminal Emulation board uses
address range 0000-CFFF. This range conflicts with the
PS2EMM.SYS expanded memory manager, which uses address
range A000-FFFF. The device = line would be the following :

deuice=ps2enn .sys Ix=0000-CFFF



The /x parameter tells PS2EMM.SYS to exclude the address
range used by the emulation board, and thus prevents the
memory conflict.

Q : I have an EGA card with 64K of memory, and an

	

EGA card :
enhanced color monitor. When I run Windows I get color,

	

low-resolution color
but only in low resolution .
A : Windows requires an EGA card with more than 64K of
memory to run high-resolution color (640 x 350, in eight
colors).

Q: All of my applications, except Windows, run in color on Running Windows in
my IBM Personal System/2 Model 30 Can I run Windows in

	

color on an IBM PS12
color?

	

system
A : Windows will not run in color on the IBM PS/2 Model 25
or Model 30. These models use the multi-color graphics array
adapter, which does not have the memory capacity to display
color in addition to the Windows graphics .
Windows will run in color on an IBM PS/2 Model 50, 60, or
80. These models use the video graphics array adapter .

Q : Why do files beginning with a tilde () and ending with Files beginning with a
a .TMP extension appear in my root directory when I exit

	

tilde (1
Windows? Can I delete them?
A: These files are temporary files created by some Windows
applications and they remain after you exit Windows
unexpectedly.
Do not delete temporary files during a Windows session ; your
application may still need them. Temporary files can be
deleted after quitting Windows .
For more information on temporary files, see Chapter 1,
"Getting Started," in the Microsoft Windows User's Guide.

Q: I accidentally deleted several Windows files . Can these

	

Recovering a deleted
files be recovered from the .TMP files?

	

file
A : Windows applications delete .TMP files when you quit the
application. However, if you are working with a particular file
and restart your computer by using CONTROL + ALT + DELETE
instead of quitting your application, a .TMP file is saved .
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To find the .TMP file and recover your deleted data, follow
these steps :

El

4

4

El

From MS-DOS Executive, select the directory containing
.TMP files (the directory specified by the set TEMP line in
your AUTOEXEC.BAT file).
Locate the .TMP file that begins with a tilde (~) followed by
three characters matching the extension of your deleted
file. For example, the .TMP file for a Windows Write file
begins with rWRI.
If more than one .TMP file exists, select the View menu
and choose the Long command to see which file most
closely matches the size or date of the deleted file .
Rename the .TMP file using its original name .

Press ENTER.

To test the new keyboard repeat rate, follow these steps :

Select the Test Typematic text box .
Press and hold down any character key and observe the
repeat rate .
Adjust the repeat rate, or press ENTER.

Setting keyboard
repeat rate

Q :
A :

Is there a way to change my keyboard repeat rate?
To change your keyboard repeat rate, follow these steps :

El Start Control Panel by running the CONTROL .EXE program
from MS-DOS Executive .

11 Select the Preferences menu and choose the Keyboard
Speed command.
Select the setting you want .
The farther right the blinking indicator, the faster the key-
board repeat rate will be .
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